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Pharmacokinetic Case Study NAPA Bioavailability 

 
N-Acetylprocainamide (NAPA) Kinetics: 

Bioavailability Estimated by a Stable Isotope Method 
 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 
This case study will show you how to analyze the data from a study of absolute 
bioavailability in which an intravenous (iv) dose of stable isotope-labeled drug was 
injected at the same time as the conventional formulation was administered orally. You 
will learn how to deal with the time lag that occurs between the time of oral dose 
administration and its first appearance in plasma. This time lag reflects the time required 
for tablet dissolution and gastric emptying. You will learn: 
 

• How to analyze data generated from studies of absolute bioavailability 
(simultaneously fitting iv and oral data). 

• How to use the delay tool to model an absorption time lag. 
• How to use the duplicate feature to duplicate a model structure. 
• How to save results to a text file for report writing. 

 
Data Required 
 

The data file for this case study is 
 

napa.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
Bioavailability is defined as the relative amount of a drug administered in a 
pharmaceutical product that enters the systemic circulation in an unchanged form, and the 
rate at which this occurs [1]. If the drug is administered iv, obviously 100% is absorbed. 
When the comparison is made between an oral (or other non-iv route of administration) 
and an iv dose, the absolute bioavailability of the drug is measured. 
 
The situation can be described in the context of the following figure; this represents the 
model that will be developed in this case study. 
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In this model, Compartment 4 represents plasma; iv administration of a drug is into this 
compartment. Compartment 7 represents the first part of the gut. Since there is usually a 
time lag between the time a drug is taken orally and it appears in plasma, a delay, 
represented above by the box “8,” is required in the model. In terms of bioavailability, 
one cannot tell the difference between a loss from Compartment 7 or the Delay 8; it is 
usually modeled as a loss from Compartment 7 (this has no effect on estimation of 
bioavailability). 
 
The fraction absorbed and the rate at which the drug is absorbed can be calculated from a 
knowledge of the rate constants k(8,7) and k(0,7); this will be illustrated below. 
 
Bioavailability cannot be estimated from an oral dose alone with only plasma samples. 
The reason is that the system model, represented by compartments 4, 5 and 6, cannot be 
estimated along with the absorption characteristics, compartment 7 and delay 8. 
 
In most instances, absolute bioavailability is studied by administering iv and oral doses of 
a drug to a subject on two different occasions. In this way, one can determine the system 
model from the iv data and absorption by simultaneously analyzing the iv and oral data. 
This not only requires two separate studies and sets of blood samples, but requires the 
assumption that the pharmacokinetic parameters characterizing drug distribution and 
elimination have remained unchanged between the two studies. This assumption is 
particularly tenuous when bioavailability is being evaluated in the patient population for 
whom the drug is intended rather than in normal subjects.  
 
This problem can be overcome by using a stable isotope labeled drug; in this way, the 
labeled drug can be administered iv and the conventional, unlabeled drug formulation can 
be administered orally [2]. Both compounds then can be measured simultaneously in 
plasma using a mass spectrometer coupled to either a gas chromatograph, as in this case, 
or to a high-performance liquid chromatograph. The data for this case study were taken 
from a study in patients who were candidates for therapy with this antiarrhythmic drug 
[3]. 
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Part 1. Analyze the data resulting from intravenous administration of  NAPA-13C. 

The first step will be to create a 3-compartment system model to describe the kinetics of 
the iv dose of stable isotope labeled NAPA. The data, NAPA_IV found in the data file 
napa.dat, are plasma samples following a 5-minute infusion of NAPA-13C. 

 

 Which system model structure? The 3-compartment model is chosen here 
because a priori knowledge from the literature suggests this is the most 
appropriate. Using information from the literature can help you in the system 
model development process. You must be sure, however, that the experiment 
in the literature is similar to yours, especially the sample times. A richer set of 
samples will often indicate a more complex model. 

 
If you are unsure of the model used in the literature, you should start first with 
the two-compartment model, and then move to the three- and four-
compartment models to be sure the three-compartment model is in fact the 
most appropriate for your data. In this case, the central compartment had 
previously been shown to correspond to intravascular space, corrected for 
RBC/plasma partitioning. The slow and fast equilibrating peripheral 
compartments are primarily composed of splanchnic and somatic tissues, 
respectively.  

 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. In the SAAM II Toolbox, be sure the Model tools are 
available. 

 
2. Create the following system model on the Drawing Canvas: 
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3. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 

unavailable and the Experiment tools are available. The Experiment Attributes 
dialog box will open. 
 
a. Leave “minutes” in the Units box. 
 
b. Enter “720” in the End at box. The Experiment Attributes dialog box will 

appear as follows: 
 

 
 

c. Click Done. 
 

The Create Experiment dialog box will appear on the Drawing Canvas. Type 
“NAPA” in the New Name box. The Create Experiment dialog box will appear 
as follows: 
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d. Click Create. Notice “NAPA” appears as the name beneath “Experiment” in 
the SAAM II Toolbox. 

 
4. Create a sample. 

 
a. In the SAAM II Toolbox, click Sample. 
 
b. Click compartment q1, then click on the Drawing Canvas. The sample s1 

will appear. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “mcg/mL” in the Units box. 
 

 Units. The units of the data are micrograms/milliliter. Normally this would be 
written μg/ml or μg/mL. SAAM II does not accept μ for micro. Writing the 
units mg/ml would be normally interpreted as micrograms/ml. Thus writing 
the units mcg/mL is a convenient way to denote the microgram. 

 
 
e. Type “NAPA_IV” in the Associate with Data Name box. 
 
f. Edit the sample equation “s1 = q1” to read “s1 = q1/V1”. The Sample 

Attributes dialog box will appear as follows: 
 

 
 
g. Click Done. The following Warning message will appear:  
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h. Click OK.  
 

5. Create an input. 
 
An intravenous dose of 271 mg of NAPA-13C was infused over 5 minutes. 
 
a. In the SAAM II Toolbox, click Input 
 
b. Click compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 
c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Select Infusion as the Input Type. 
 
e. Enter “54.2” in the Constant Rate box. 
 
f. Enter “0” in the Event Start box. 
 
g. Enter “5” in the Event Stop box. 
 
h. Click Add. The Exogenous Input dialog box will appear as follows: 
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i. Click Done. 

 
6. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file napa.dat should appear in the list (if it 

does not, find the folder where you have put this data file). 
 
c. Double-click napa.dat. The data file contains NAPA data following the 5 

minute constant infusion, NAPA_IV, and following the oral administration, 
NAPA_oral. The oral data will be used later. The Data window appears as 
follows: 
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The weighting scheme is FSD so you can leave the variance model set as the 
default data-relative. Note that the first NAPA_IV data point is followed by 
“(-)” to unweight it. The reason will be explained in more detail below. Note 
also that measurable NAPA from the oral dose first appears in plasma 60 
minutes after the dose is administered. This will be modeled using the delay 
tool in Part 2 of this case study. 

 
d. Close the Data window. 
 

7. View your data using a line plot. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. 
 
b. Be sure the List All Variables check box is selected. (Click this box if it is 

not selected). 
 
c. Click NAPA_IV to move it to the Current Selection pane. 
 
d. Click Done. A plot of your data will appear in the Plot window. 
 
e. In the View menu, click Line Plot. 
 
f. In the View menu, click Semilog. Your plot will appear as follows: 
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 Line Plots. Using the line plot in semilog mode to connect your data can help 
you decide how many exponentials (compartments) will be needed for the 
model. In this case, it is clear that at least two exponentials, or compartments, 
will be needed. However, three is more likely because the break in the curve is 
not “sharp” which would indicate a two-compartment model. Thus the three-
compartment model discussed in the literature is probably appropriate. 

 
 

g. Close the Plot window. 
 

8. Enter parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 

The parameter V1 should be selected. If it is not selected, double-click V1. Be 
sure the Adjustable option is selected. 
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b. Enter “5” in the Value box, “3” in the Low Limit box, “10” in the High 
Limit box, and click Save. 

 
c. Double-click k(0,1) to select it. 
 
d. Enter “0.02” in the Value box, and click Save. 
 
e. Double-click k(1,2) to select it. 
 
f. Enter “0.1” in the Value box, and click Save. 
 
g. Double-click k(1,3) to select it. 
 
h. Enter “0.007” in the Value box, and click Save. 

 
i. Double-click k(2,1) to select it. 
 
j. Enter “0.2” in the Value box, and click Save. 
 
k. Double-click k(3,1) to select it. 
 
l. Enter “0.1” in the Value box, and click Save. 

 
When you have finished, your Parameters dialog box should appear as follows: 
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m. Click Done. 

 
9. Save your study file. 
 

a. In the File menu, click Save As. 
 
b. Type “napa_iv” in the File Name box. 
 
c. Select the folder where you wish to save the file in the Save In box. 
 
d. Click Save. 

 
10. Prepare to save the results of your modeling session so you can write a report. 
 

a. In the Compute menu, click Settings. The Computational Settings dialog 
box will open. 

 
b. Select the Save Results to Text File box. 
 
c. In the Level pane, select Basic. 
 
d. In the File pane, select Add. The Computational Settings dialog box will 

appear follows: 
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e. Click Done. 

 

 Report writing. SAAM II supports writing information to a text file which can 
then be used to write a report of your modeling session. There are three levels 
of information saved; they are basic, detailed and all. The difference between 
these options is explained in the Addendum to the SAAM II User Guide that 
accompanies version 1.2. In addition, you can “Replace” or “Add” to the text 
file. If you select the “Replace” option, when you save, the previous text file, 
modelname.txt, will be overwritten. If you choose “Add,” a new text file will 
be created but the original text file will be retained. In this case, “Add” is 
selected because the model development is step-wise and needs to be 
recorded. 

 
When the “Add” option is chosen, each time you Solve or Fit, SAAM II will 
create a text file. Since you have saved your study file as napa_iv , the text 
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files will be named “napa_iv” with a number after it so you can sequentially 
keep track of the order in which you “Solved” or “Fitted.”  

 
 

11. Solve your model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Since you had previously plotted your data, the Plot window 
will open. To plot the model solution, on the Set menu, click Plot/Table 
Variables. The Plot and Table Variables dialog box will open. 

 
c. In the Plot and Table Variables dialog box, clear the List All Variables 

check box to list only those variables associated with data. 
 
d. Click s1:NAPA_IV; it will move to the Current Selection pane. 
 
e. Click Done. The following plot will appear (in semilog mode): 
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The initial estimates are reasonable in that the shape of the curve parallels the 
data. If you wish to hand-fit to improve the initial estimates, you should adjust 
the value for V1 since this parameter acts as a linear scale factor. Leave the 
Plot window open. 

 
12. Fit the model to the data and view the solution.. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . When you have “Fitted” your model to your data, your plot 
should appear as follows (the Scale has been changed for better visualization; 
the X Axis maximum is 750, and the Y Axis minimum and maximum are 
respectively 0.4 and 20): 
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Note that the first data point is marked with a red x because it was 
unweighted. 

 
b. Close the Plot window. 
 
c. View the results in tabular form. 
 

(1) In the Show menu, click Table, or alternatively, on the SAAM II 

Toolbar, click Table . The Plot and Table Variables dialog box will 
not open since s1:NAPA_IV is already selected. The table will appear as 
follows: 
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Note that the “Fit” to all but the first point is reasonably good. The 
concentration of the first data point is substantially below expected value 
for s1 because it was drawn immediately at the end of the infusion and 
intravascular mixing was incomplete. This mixing process usually requires 
2 to 3 minutes. This is the rationale for unweighting this point. 

 
(2) Close the Table window. 

 
d. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . The Statistics window will appear as follows: 
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It is apparent from the Coefficients of Variation in the Statistics window that 
the model parameters are moderately well determined. 
 

e. Close the Statistics window. 
 

 Report writing (continued). You have performed two computational operations 
so far, one Solve and one Fit. Since you have selected the Save Results to 
Text File option in the Computational Settings window, SAAM II has 
automatically created two text files. You can view these text files by opening 
them (they are called napa_iv.txt and napa_iv_01.txt) in a text editor. 

 
 
 
Part 2. Analyze the data resulting from oral administration of NAPA. 
 
In the second part of this case study, a model describing the data following  oral 
administration of NAPA will be postulated. The model will consist of two parts. The first 
part is the “system” model, i.e. a model describing the behavior of the drug once it enters 
plasma. The second part will describe how the drug is absorbed after oral administration. 
In postulating the “system” model, it is assumed that the disposition kinetics of  
NAPA-13C administered as an iv infusion and NAPA administered orally are identical. 
That is, the system model is the same for both. 
 

1. In the SAAM II Toolbox, be sure the Experiment tools are available. (You can 
Duplicate if either the Model or Experiment tools available. However, if only 
the Model tools are available, the samples will not be available for duplication.) 
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2. Duplicate the model for NAPA-13C. 
 

a. While pressing the CTRL key, click compartments q1, q2, q3 and s1 in this 
specific order. 

 
b. In the Edit menu, click Duplicate. The Duplicate dialog box will open. 
 
c. Important: Check the Set New Parameters Transfer Coefficients equal to 

counterparts box. The Duplicate dialog box will appear as follows: 
 

 
 
d. Click Duplicate and click on the Drawing Canvas approximately where you 

would like the duplicated model to be inserted. The following two models 
(after rearrangement) will appear on the Drawing Canvas as follows: 
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 Duplicating. There are occasions when you would like to have a duplicate 
copy of a model. In this case study, one model describes the intravenously 
administered drug. The other will describe oral absorption. The system model, 
i.e. the drug behavior in the body, is the same for either administration. Thus 
one would like to duplicate the model and have corresponding rate constants 
the same. As you will see, a structure to describe absorption will be added to 
the model consisting of Compartments q4, q5 and q6. 
 
The order in which the compartments and samples are clicked affects the 
restructuring of the duplicated model. 

 
 

3. Modify the sample s2. 
 
a. Double-click s2 to open the Sample Attributes dialog box. 
 
b. Type “mcg/mL” in the Units box. 
 
c. Type “NAPA_oral” in the Associated with Data Name box. 
 
d. Edit the sample equation “s2 = q4” to read “s2 = q4/V4”. The Samples 

Attributes dialog box will appear as follows: 
 

 
 
e. Click Done. 

  
4. Create the model for oral absorption. 
 

a. In the SAAM II Toolbox, click Model to be sure these tools are available. 
These tools need to be available to define new transfer compartments, fluxes 
and delay attributes. 

©University of Washington PK.NapaBio - 19 Rev. 08/10/13 



Pharmacokinetic Case Study NAPA Bioavailability 

 
b. In the SAAM II Toolbox, click Compartment. 
 
c. Click on the Drawing canvas where you would like Compartment 7 to be 

located. Place it near the left margin of the Drawing Canvas so that a delay 
and transfers can be added. Compartment 7 will appear on the Drawing 
Canvas as shown below. 

 
d. In the SAAM II Toolbox, click Delay. 
 
e. Click on the Drawing Canvas where you would like the delay to be located. 

Place it between Compartments 7 and 4. Your model for the oral dose should 
appear as follows: 

 

 
 
f. Add the fluxes k(8,7), k(0,7) and d(4,8). Your model for the oral dose should 

appear as follows: 
 

 
g. Define the delay attributes 
 

(1) Double-click Delay 8 to open the Delay Attributes dialog box. 
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(2) Enter “gut” in the Reference Name box. The Delay Attributes dialog box 
will appear as follows: 

 
(3). Type “tlag” in the Delay Time box. This will introduced a new parameter, 

tlag, into the model; it will represent the time of the delay in absorption of 
NAPA. 

 
(4) Enter “5” in the Number of Compartments box  

 
 

 
 

(5) Click Done. Notice the word “gut” now appears associated with Delay 8. 
 
 

5. Create the oral input 
 

a. In the SAAM II Toolbox, click Experiment to make these tools available. 
 
b. Click Input in the SAAM II Toolbox. 
 
c. Click Compartment q7, and then click on the Drawing Canvas. The input ex2 

will appear. 
 
d. Double-click ex2 to open the Exogenous Input dialog box. 
 
e. Make sure that Bolus is selected as the Input Type. 
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 f. Enter “467.8” in the Initial Amount box. This is the assayed amount of 
NAPA base in a 500 mg tablet of NAPA-HCl. (In general, the expected 
amount is 442.5 mg). 

 
g. Enter “0” in the Event Start box. 
 
h. Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 

i. Click Done. 
 

6. Enter the following equations and parameters to complete the oral dose model. 
 

a. In the Show menu, click Equations, or alternatively, on the SAAM II 

Toolbar, click Equations . The Equations dialog box will open. 
 
 
b. In the Equations Defined Here pane, type the following equations: 
 

“V4 = V1” 
“F = k(8,7)/(k(8,7) + k(0,7))” 

 
The first equation makes the intravascular distribution volume for the iv and 
oral dose equal. This second equation defines the extent of drug absorption as 
the absorption rate constant divided by the sum of the rate constants 
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describing absorption and non-absorptive loss from the intestine. The 
Equations dialog box should appear as follows: 
 

 
 

c. Close the Equations dialog box. 
 

7. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 
b. Double-click k(0,7) to select it. 
 
c. Enter “0.01” in the Value box, and click Save. 
 
d. Double-click k(8,7) to select it. 
 
e. Enter “0.03” in the Value box, and click Save. 
 
f. Double-click tlag to select it. 
 
g. Enter “150” in the Value box, “100” in the Low Limit box, “200” in the High 

Limit box, and click Save. Your Parameters dialog box should appear as 
follows: 
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h. Click Done. 
 

8. Save the study file as napa_oral. 
 

9. Solve your model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open (if a 
previous plot appears, on the Set menu, click Plot/Table Variables to open 
the Plot and Table Variables dialog box.) 

 
c. In the Plot and Table Variables dialog box (Clear the List All Variables 

check box if checked to list only those variables associated with data.) 
 
d. Click s2:NAPA_oral; it will move to the Current Selection pane. 
 
e. Click Done. The following linear plot will appear (in this plot, the Y Axis 

maximum has been set to “2.6”): 
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Leave the Plot window open. 

 
10. Fit the model to the data and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . When you have “Fitted” your model to your data, your plot 
should appear as follows: 
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Notice that this plot is in the linear mode; this helps you to see how the delay 
works during the first 50 minutes where there is a definite lag in the 
appearance of drug followed by a very gradual rise in plasma concentration. 
The steepness of this rise in concentration is determined by the number of 
compartments in the delay.  

 
b. Plot both sets of data and model predictions. 
 

(1) Be sure the Plot window is current. In the Set menu, click Plot/Table 
Variables to open the Plot and Table Variables dialog box. 

 
(2) Select s1:NAPA_IV and s2:NAPA_oral. 
 
(3) Click Done. 
 
(4) In the Set menu, click Plot/Table Scale to open the Plot and Table Scale 

dialog box. 
 
(5) In the X Axis pane, select Set. Enter “750” in the Maximum box. 
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(6) In the Y Axis pane, select Set. Enter “0.1” in the Minimum box and “20” 
in the Maximum box. 

 
(7) Click Done. Your plot in semi-log mode should appear as follows: 
 

 
 
As is usually the case, the model fits the data obtained after intravenous 
administration of NAPA-13C better than that resulting from the oral NAPA 
dose. 
 
(8)  Close the Plot window. 

 
c. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . The Statistics window will appear as follows: 
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The value for tlag is 154 with a 32% error and a 95% confidence interval of 51 to 
258. Scroll to the bottom of the Parameter/Variable pane to see the remaining 
parameters: 

 

 
 

The value for F indicates that 76% of the oral NAPA dose was absorbed. The 
95% confidence interval for this estimate is 67% - 85%. In the five patients that 
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were studied it was found that F estimated in this way averaged 78.0% compared 
to 92% in the normal subjects that were studied initially.  
 
Of particular interest is the fact that values for F in these five patients with cardiac 
disease were correlated with estimated intercompartmental clearance to the fast 
equilibrating peripheral compartment, that presumably includes splanchnic organs 
(r = 0.89, p = 0.045). 
  

 
 
This suggests that splanchnic blood flow, which is decreased in patients with 
diminished cardiac output, is a determinant of the bioavailability for this, and 
probably a number of drugs that are commonly used. 
 

 Report writing (continued). You have performed two more computational 
operations so far, one “Solve” and one “Fit”. Since you have selected the Save 
Results to Text File option with Add, SAAM II has automatically created 
two new text files, this time named napa_oral.txt since you saved your study 
file as napa_oral. You can view these text files my opening them in a text 
editor. The last, napa_oral_01.txt, is printed in the Appendix so you can see 
what the output looks like. 

 
 

 Dealing with poorly estimated parameters. If you look at the statistics 
following this fit, you will see that the parameters k(0,7) and k(8,7) are poorly 
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determined with errors in excess of 100%. This means they cannot be 
estimated with any degree of precision. However, bioavailability F which is a 
function of these two parameters can be estimated with good precision. This is 
an example frequently seen in the analysis of biological or pharmacokinetic 
data where specific parameters may not be well estimated, but function of 
them can be. If one is only interested in F, then it is probably safe to stop here. 

 
 Is there a way to deal with this? The answer is “yes” if you are willing to 

introduce a constraint on the parameters to reduce the degrees of freedom in 
your model. 

 
 One way to do this is the following. The turnover for each compartment in the 

5 compartment delay approximately equals 5/150 = 0.033. The total turnover 
for Compartment 7 is k(0,7) + k(8,7) = .046. One can thus regard 
Compartment 7 as another compartment in the delay, and fix it turnover equal 
to 0.033. F will become a parameter along with tlag (reducing the number of 
adjustable parameters from 3 to 2). 

 
 You need to define k(0,7) and k(8,7) as follows (this can be done in the 

Equations dialog box): 
 
 k(8,7) = F*5/tlag 
 k(0,7)=(1-F)*5/tlag 
 
 The Equations dialog box will appear as follows: 
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 Notice the previous equation defining F has been removed. You also need to 
enter an initial estimate for F in the Parameters dialog box; you can use 0.75. 
The Parameters dialog box will appear as shown below: 

 

 
 
 If you now Fit the model to the data, you will obtain the following results: 
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 You can see that the parameter estimates are much better with this added 
constraint, and that the value of F remains virtually unchanged. 

 
 
You may now Quit the SAAM II Compartmental application. You may save the study 
file for future reference if you wish. 
 
 
 
Essential Points to Remember 
 
• It is convenient to use the duplicate feature of SAAM II to analyze data from absolute 

bioavailability studies. 
 
• The delay tool of SAAM II is often required to model the lag time between 

administration of an oral drug dose and its appearance in plasma. 
 
• The report writing option provides a convenient way of documenting data analysis 

procedures and results. 
 
• Sometimes the parameter of interest can be well-determined even if other model 

parameters cannot. When other model parameters cannot be well-determined, one 
must seek constraints on the parameters to reduce the degrees of freedom in the 
model. 
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 Appendix:  Text File Output “napa_oral_01.txt”
 
Study Name:  napa_oral.stu 
Basic Summary Output 
Date:  01:32 PM, Saturday, July 06, 2002 
Application:  Compartmental 
Type of Calculation:  Fit 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Computational Settings 
 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Variance Model:  Data, Relative 
Derivative:  Forward 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Values at t = 0.0 minutes 
 
F                      0.760475 
NAPA_IV                 - 
NAPA_oral               - 
V1                     8.524599 
V4                     8.524599 
d(4,8)                 1.000000 
d8                     0.000000 
ex1.bolus              0.000000 
ex1.infusion          54.200000 
ex2.bolus            467.800000 
ex2.infusion           0.000000 
flux(0,1)              0.000000 
flux(0,4)              0.000000 
flux(0,7)              5.255014 
flux(1,2)              0.000000 
flux(1,3)              0.000000 
flux(2,1)              0.000000 
flux(3,1)              0.000000 
flux(4,5)              0.000000 
flux(4,6)              0.000000 
flux(4,8)              0.000000 
flux(5,4)              0.000000 
flux(6,4)              0.000000 
flux(8,7)             16.684298 
k(0,1)                 0.023293 
k(0,4)                 0.023293 
k(0,7)                 0.011233 
k(1,2)                 0.093163 
k(1,3)                 0.006807 
k(2,1)                 0.195874 
k(3,1)                 0.103970 
k(4,5)                 0.093163 
k(4,6)                 0.006807 
k(4,8)                 0.032362 
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k(5,4)                 0.195874 
k(6,4)                 0.103970 
k(8,7)                 0.035665 
q1                     0.000000 
q2                     0.000000 
q3                     0.000000 
q4                     0.000000 
q5                     0.000000 
q6                     0.000000 
q7                   467.800000 
s1                     0.000000 
s1_res                  - 
s1_wres                 - 
s2                     0.000000 
s2_res                  - 
s2_wres                 - 
t                      0.000000 
tlag                 154.500310 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Calculated Sample Values and Data 
 
 
          t    NAPA_oral       Weight           s2      s2_wres 
 0.000e+000         -            -      0.000e+000         -    
 5.000e+000         -            -      1.054e-006         -    
 5.000e+000         -            -      1.054e-006         -    
 7.500e+000         -            -      1.019e-005         -    
 1.000e+001         -            -      4.894e-005         -    
 2.000e+001         -            -      1.777e-003         -    
 3.000e+001         -            -      1.226e-002         -    
 4.500e+001         -            -      7.092e-002         -    
 6.000e+001   2.300e-001   1.055e+003   2.136e-001   5.320e-001 
 7.500e+001   4.000e-001   3.489e+002   4.524e-001  -9.783e-001 
 9.000e+001   7.400e-001   1.019e+002   7.684e-001  -2.867e-001 
 1.200e+002   1.780e+000   1.762e+001   1.473e+000   1.289e+000 
 1.500e+002   2.450e+000   9.301e+000   2.026e+000   1.294e+000 
 1.800e+002   2.030e+000   1.355e+001   2.292e+000  -9.634e-001 
 2.100e+002         -            -      2.305e+000         -    
 2.400e+002   1.910e+000   1.530e+001   2.169e+000  -1.015e+000 
 2.760e+002         -            -      1.939e+000         -    
 3.120e+002         -            -      1.723e+000         -    
 3.360e+002         -            -      1.604e+000         -    
 3.600e+002   1.520e+000   2.416e+001   1.506e+000   7.062e-002 
 3.960e+002         -            -      1.392e+000         -    
 4.320e+002         -            -      1.308e+000         -    
 4.560e+002         -            -      1.262e+000         -    
 4.800e+002   1.350e+000   3.063e+001   1.222e+000   7.089e-001 
 5.160e+002         -            -      1.169e+000         -    
 5.520e+002         -            -      1.121e+000         -    
 5.760e+002         -            -      1.091e+000         -    
 6.000e+002   1.130e+000   4.372e+001   1.062e+000   4.508e-001 
 6.360e+002         -            -      1.020e+000         -    
 6.720e+002         -            -      9.809e-001         -    
 6.960e+002         -            -      9.554e-001         -    
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 7.200e+002         -            -      9.307e-001         -    
 7.200e+002   9.200e-001   6.596e+001   9.307e-001  -8.677e-002 
 
 
          t      NAPA_IV       Weight           s1      s1_wres 
 0.000e+000         -            -      0.000e+000         -    
 5.000e+000         -            -      1.684e+001         -    
 5.000e+000   1.081e+001     Excluded   1.684e+001         -    
 7.500e+000   9.450e+000   5.175e+000   9.338e+000   2.545e-001 
 1.000e+001   6.210e+000   1.198e+001   6.305e+000  -3.284e-001 
 2.000e+001   3.920e+000   3.007e+001   3.665e+000   1.398e+000 
 3.000e+001   2.760e+000   6.067e+001   2.917e+000  -1.226e+000 
 4.500e+001   2.250e+000   9.129e+001   2.214e+000   3.459e-001 
 6.000e+001   1.730e+000   1.544e+002   1.790e+000  -7.411e-001 
 7.500e+001   1.510e+000   2.027e+002   1.531e+000  -2.944e-001 
 9.000e+001   1.430e+000   2.260e+002   1.370e+000   9.068e-001 
 1.200e+002   1.310e+000   2.693e+002   1.198e+000   1.830e+000 
 1.500e+002   1.130e+000   3.619e+002   1.115e+000   2.797e-001 
 1.800e+002   1.020e+000   4.442e+002   1.064e+000  -9.215e-001 
 2.100e+002         -            -      1.024e+000         -    
 2.400e+002   9.600e-001   5.015e+002   9.890e-001  -6.498e-001 
 2.760e+002         -            -      9.501e-001         -    
 3.120e+002         -            -      9.133e-001         -    
 3.360e+002         -            -      8.896e-001         -    
 3.600e+002   8.400e-001   6.550e+002   8.666e-001  -6.799e-001 
 3.960e+002         -            -      8.331e-001         -    
 4.320e+002         -            -      8.010e-001         -    
 4.560e+002         -            -      7.803e-001         -    
 4.800e+002   7.500e-001   8.216e+002   7.601e-001  -2.889e-001 
 5.160e+002         -            -      7.308e-001         -    
 5.520e+002         -            -      7.026e-001         -    
 5.760e+002         -            -      6.844e-001         -    
 6.000e+002   6.800e-001   9.994e+002   6.667e-001   4.209e-001 
 6.360e+002         -            -      6.410e-001         -    
 6.720e+002         -            -      6.163e-001         -    
 6.960e+002         -            -      6.003e-001         -    
 7.200e+002         -            -      5.848e-001         -    
 7.200e+002   5.900e-001   1.328e+003   5.848e-001   1.905e-001 
---------------------------------------------------------------------------------------- 
---------------------------------------------------------------------------------------- 
 
Statistics 
 
Parameter/Variable      Value      Std.Dev. Coef. of Var.  95% Confidence Interval 
------------------    -------      --------  -------------    ----------------------- 
V1                    8.52460  2.93733e+000  3.44571e+001       2.35351      14.69569 
k(0,1)                0.02329  7.90278e-003  3.39273e+001       0.00669       0.03990 
k(0,7)                0.01123  2.11982e-002  1.88706e+002      -0.03330       0.05577 
k(1,2)                0.09316  1.13753e-002  1.22101e+001       0.06926       0.11706 
k(1,3)                0.00681  5.45327e-004  8.01107e+000       0.00566       0.00795 
k(2,1)                0.19587  5.66938e-002  2.89440e+001       0.07677       0.31498 
k(3,1)                0.10397  3.18669e-002  3.06500e+001       0.03702       0.17092 
k(8,7)                0.03567  6.89233e-002  1.93249e+002      -0.10914       0.18047 
tlag                154.50031  5.04022e+001  3.26227e+001      48.60935     260.39127 
--------------------------------- Derived Variables --------------------------------- 
F                     0.76047  4.29565e-002  5.64864e+000       0.67023       0.85072 
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V4                    8.52460  2.93733e+000  3.44571e+001       2.35351      14.69569 
k(0,4)                0.02329  7.90278e-003  3.39273e+001       0.00669       0.03990 
k(4,5)                0.09316  1.13753e-002  1.22101e+001       0.06926       0.11706 
k(4,6)                0.00681  5.45327e-004  8.01107e+000       0.00566       0.00795 
k(4,8)                0.03236  1.05575e-002  3.26227e+001       0.01018       0.05454 
k(5,4)                0.19587  5.66938e-002  2.89440e+001       0.07677       0.31498 
k(6,4)                0.10397  3.18669e-002  3.06500e+001       0.03702       0.17092 
 
                          Objective      Scaled Data Variance 
s2 : NAPA_oral         -1.329932e+000       1.791237e+000 
s1 : NAPA_IV           -2.722407e+000       2.163830e-001 
                       -------------- 
Total objective        -4.052340e+000 
 
AIC                    -6.998239e-001 
BIC                    -4.358571e-001 
 
Number of Iterations Required to Fit: 3 
---------------------------------------------------------------------------------------- 
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Data for this Case Study 
 
DATA 
(FSD 0.1) 
t NAPA_IV NAPA_oral 
0. none  none 
5.0 10.81(-) none 
7.5 9.45  none 
10.0 6.21  none 
20.0 3.92  none 
30.0 2.76  none 
45.0 2.25  none 
60.0 1.73  0.23 
75.0 1.51  0.40 
90.0 1.43  0.74 
120. 1.31  1.78 
150. 1.13  2.45 
180. 1.02  2.03 
240. 0.96  1.91 
360. 0.84  1.52 
480. 0.75  1.35 
600. 0.68  1.13 
720. 0.59  0.92 

END
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